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Net UI Module
The Net UI feature, installed with the Net UI (NUIM) Module, provides a method for accessing the Fourth 
Shift system, including across an intranet, phone line or the Internet. Net UI can also be used across a 
local area network (LAN) to improve performance by eliminating much of the network traffic. The Net UI 
Module contains add-on components that reside on both the client and on server computers.

This section contains both background information about Net UI and information about installing and 
configuring your environment to use Net UI. 

Net UI Concepts

Net UI Architecture
The Net UI architecture extends the client/server relationship to allow the server to act as the 
"host" to a client connection. This means that the client performs fewer operations and the 
server performs more operations. The net result is faster performance for the client.

Clients access Fourth Shift either directly (traditional clients) or through the Net UI server (Net 
UI clients). Any combination of client access methods can be used simultaneously and look 
similar to the following:

Client Operation
Net UI clients are different from traditional clients in a number of ways:

• Installation Process. Users can install client components by downloading files from a web 
page or running the standard workstation installation. 

Fourth Shift databases/applications

Thin Client: web page access

Internet

LAN

Modem Bank

Thin Client: modem access

Net UI server

Standard Client

LAN

Intranet, or LAN
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• Installation Components. Any files, such as screen definitions, which need to be accessed 
by the client are installed on the Net UI client. The components are accessed directly from the 
client and communication time is minimized between the client and server.

• Client Connection Operation. Net UI clients communicate with the Net UI server and a two-
way client connection is started. The Net UI client communicates with the Net UI server and 
also starts an application client connection which runs the application programs on the 
server. Active client connections are listed in the Net UI Server dialog box on the Net UI 
server.

This means that any communication software, such as dial-up networking, must be able to 
reach the Net UI server. The client and server communicate through a predefined port 
number. 

• Data Communication. Net UI clients run the user interface and application programs from 
different machines to optimize performance. The user interface runs from the Net UI client 
directly. The application programs are run from the server after the Net UI connection is made. 
This allows the high performance server to do most of the processing and communicate the 
minimum amount of data across the connection to the Net UI client.

• Startup. Net UI clients must access the Net UI server to establish a connection to Fourth Shift. 
Remote users connect through either a web page link or through a user-created shortcut. See 
"Web Page Access for Remote or Local Users" or "Net UI Client Shortcut Parameters" in this 
manual for more information. Net UI users on a LAN can use the Net UI shortcut installed 
during the workstation installation process.

• User Identification. Each client must have a user-specific subdirectory on the Net UI server. 
This subdirectory has the same name as the Net UI Id entered when a Net UI client accesses 
a Net UI server. 

Net UI Server
The Net UI server is a component which runs on a Windows server. This component manages the 
activities of any Net UI clients. It monitors access by starting and stopping connections as clients 
use Fourth Shift through Net UI. A running Net UI server program supports a single Fourth Shift 
database, and multiple NET UI server programs can be run for multiple Fourth Shift systems.

The Net UI server uses the following concepts:

• Communication. The Net UI server communicates with clients through a predefined port 
number. A port number is similar in concept to a telephone number. Fourth Shift clients specify 
the port number they are trying to "call" to connect to the Fourth Shift server. 

The port number is set by default to 5432 but can be changed as needed. The Net UI server 
then "listens" for client connection requests to connect to that port number.

• Client Connections. Once a client access request is received by the server, an application 
session is created on the server to process Fourth Shift requests. This connection is no 
different from starting a Fourth Shift session from the server manually except that the user 
interface is displayed on the Net UI client. Active client connections are listed in the Net UI 
Server dialog box on the Net UI server.

• User Identification. Each client must have a user-specific subdirectory on the Net UI server. 
This subdirectory has the same name as the Net UI Id entered when a Net UI client access a 
Net UI server. 
Net UI 5
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Client Types
There are several types of clients which can be used with your Fourth Shift system to address a 
number of business and user requirements. You may have users who travel or you may need to 
access sites in different geographical areas. You can use any combination of these client types to 
address your needs.

In general, there are two categories of Fourth Shift users: local and remote.

• Local users are connected directly to the LAN. These users require no special dial-up or 
other connection to access the network.

- Access with a traditional client. Clients are attached to the local area network using 
traditional methods. This method is used without the Net UI Module installed when 
there are no special access requirements.

- Access with a "thin" client. Clients are attached to the local area network using 
traditional methods. This access method differs from the traditional client method 
because it uses Net UI to run programs on the server and not on the client. The 
application programs are run on the server and application program to database 
processing is not communicated across the local area network.

• Remote users are not connected directly to the LAN and use some sort of communication 
technology to access information either through dial-up networking or the Internet. 

- Access using a modem. Clients access the network through a phone line. Once 
attached to the network, clients can sign onto Fourth Shift using Net UI. The 
application programs are run on the server and application program to database 
processing is not communicated on the phone line. Dial-up communication software, 
such as into a modem bank, should be used. 

- Access using the Internet. Clients access a web page to sign onto the system. A 
button on the web page starts the system using Net UI, and allows you to sign on. The 
application programs are run on the server and application program to database 
processing is not communicated across the Internet. 

A web page (FSWEB.ASP) is provided in the MFGSYS\WEB\NUIM directory that can be used 
to access Fourth Shift. See Installing Net UI for more information on implementing the web 
page.

Installation Process
Net UI installation consists of several parts:

• Module installation for the Net UI Module is similar to any other module. Several additional 
steps may be needed, once you complete the module installation, to prepare for client access.

• Server configuration includes setting up remote user access software, preparing for Internet 
access (if applicable) and establishing security for the Windows server where the Net UI 
server will run. This is needed to ensure that users cannot access non-Fourth Shift data 
inappropriately.

• Client installation may involve both third-party communication and Net UI components 
depending on the client type selected. This manual only covers the Net UI components. 
Communication software setup varies based on the packages you are using. Client 
installations also vary based on whether users install from the web page or by using the 
workstation installation program for LAN access.
Net UI 6
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See Installing Net UI in this manual for more information.

Net UI User Id
One additional step is required when you sign on using Net UI. In order to sign on using a thin 
client, you must also enter a Net UI user identifier. Each client must have a user-specific 
subdirectory on the Net UI server. This subdirectory has the same name as the Net UI Id entered 
when a Net UI client access a Net UI server. The Net UI thin client identifiers must be unique.

This User Id is used to name a subdirectory of the FSUSER directory on the machine running the 
Net UI server. For example, if you enter USER1 as your Net UI identifier, your user directory on 
the Net UI server is \FSUSER\SystemName\USER1. 

The Net UI Id can be specified using one of the following methods:

• Manual entry when you sign on using Net UI. You will be prompted to enter your Net UI Id 
before signing into Fourth Shift.

• Command line of the shortcut used to start your Net UI client. This eliminates the need to 
specify your Net UI Id each time you start your Net UI client. See "Net UI Client Shortcut 
Parameters" for more information.

Requirements

Server Requirements
It is common to run the Net UI server on the same server that is used as the Fourth Shift database 
server. 

The Net UI server must be:

• run on a supported Windows Server version according to the Fourth Shift Product Support 
Matrix

• visible across the Internet (external DNS registration)

If you need more information about these requirements, please consult your Windows server 
documentation.

Microsoft Internet Information Server (IIS)
If you choose to include the Internet access method as one of the options for client access, 
Microsoft Internet Information Server (IIS) must be on the server. The IIS software allows the 
server to respond to client access from Internet Explorer. You also need IIS to allow Net UI clients 
to download installation files from the web page.
Net UI 7
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Remote Access Requirements
Clients not directly connected to your LAN are considered "remote" clients in this manual. Remote 
clients have the following requirements to sign onto Fourth Shift:

• TCP/IP servicing connection method to your network or connection through an ISP (Internet 
Service Provider) to the Internet

• installed Net UI components 

Local Network Access
To provide access to your LAN for a remote client, you need to consider the following:

• Dial-up Application. A dial-up application which can create a TCP/IP connection must be 
available on the client. A modem bank, such as Shiva or another similar application, can be 
used to create this connection. You can use applications such as RAS or Citrix; however, the 
performance may not be acceptable in all situations. Applications such as PC Anywhere are 
not recommended for use with Net UI.

• Name Resolution. The client must be able to access the Net UI server using name resolution 
(DNS lookup). Name resolution can be verified by using the PING utility from the client to 
access the server. Alternatively, you can add the relationship between the server name and 
the IP address manually to the LMHOST or LMHOSTS file on the client.

Internet (Web Page) Access
• Connection to the Internet. A TCP/IP connection to the Internet through an ISP must be 

available on the client. A dial-up application is used to connect to the ISP but there are no 
specific requirements on how that connection is made.

• Internet Explorer 6.0 or higher is required to install or run a Net UI client using the web page.

Net UI Security
System security must be carefully considered when using the Net UI Module on an Internet server. 
Any additional security required for implementing Net UI client access via the Internet, for 
example, should be considered before implementation.

The following security issues and suggestions should be considered:

• If you plan to allow Net UI client access over the Internet, your Fourth Shift server should be 
located inside a firewall in order to prevent unauthorized access to the system.

• Local network clients use the local area network security implemented in your company.

• Remote modem clients require additional security considerations. 

The following diagram illustrates the client access routes for which security should be considered.
Net UI 8
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In this diagram, remote Internet client access is verified by firewall security. Remote modem client 
access is verified by modem bank security. Both client types are then verified by the LAN and 
Windows security.

Firewall Security
If a firewall is used to secure your Fourth Shift server, the port number used for server-client 
connections must be opened on the firewall to allow Net UI traffic to pass through. The default port 
number for the Net UI server is 5432.

Port 80 or 443 may also need to be opened on the firewall if:

• your company has a web page using port 80 for HTTP traffic

• your company has a web page using SSL port 443 for HTTPS traffic

• you wish to allow Net UI installation file downloads from the web page 

• access is also need to another server across the Internet

A security risk may exist if both ports 5432 and 80 or 443 are open to a server on the firewall 
because port 80 allows HTTP traffic and 443 allows HTTPS traffic to pass through the firewall. If 
port 80 or 443 is open and no other security is provided for access to your Fourth Shift web page, 
it is possible that any Internet user can download the Fourth Shift thin client from the web page.

If ports 5432 and 80 or 443 must be open, you should implement additional security from the web 
page where the Net UI client components are downloaded. Any additional security should validate 
the user trying to download the client components. For example, place the files on a secured 
NTFS volume to allow security verification before the download.

Firewall

Windows NT Server:
- Fourth Shift Application Programs
- Net UI
- IIS
- Databases

Thin Client

Internet

LAN

Modem Bank

Thin Client
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Application and User Level Security
The Windows server, where the Net UI server is running, needs special security to support the 
client connections and restrict users from accessing server files which are not related to using 
Fourth Shift. The Fourth Shift application session created for a Net UI client inherits the profile of 
the currently logged-on server user (that is the user who started the Net UI server program).

You should create a "basic user" account (such as NETUI) and assign the appropriate directory 
access. When you logon to the Windows server, you should use this basic user account rather 
than an Administrator account that allows the client connection more access than is needed.

Access must be defined for a "basic user" and should include the following considerations:

• services needed by Fourth Shift are started automatically without validation against user 
identification

• the database server and Net UI server must be able to start using the security for this basic 
user

• Net UI clients create a client connection which needs access to the standard Fourth Shift 
directory structure just like the traditional client

• Net UI server and clients need access to the Windows operating system related directories for 
programs and support files

See your Windows documentation for more information on establishing directory access if needed.

Directory Access Assignments
Assign NTFS directory access assignments to the following Fourth Shift installed directories:

Full Control Read Only

CSTM \ (root of FSHIFT directory)

FS_APPS MFGSYS\E

FS_APPS\D MFGSYS\FONTS

FS_APPS\W MFGSYS\HELP

FSUSER (including related subdirectories) MFGSYS\MSDEFS

LOTM MFGSYS\REPORTS

MFGSYS MFGSYS\S

MFGSYS\CLIENT MFGSYS\SQLMSS

MFGSYS\ENGM MFGSYS\SYSTEM

MFGSYS\I

MFGSYS\MMAM

MFGSYS\SFRM

XPORT
Net UI 10
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In addition, the following directories on the server should be secured. Any other directories on the 
server are not used by Fourth Shift and you should secure them as needed by your operation.

Domain Name Resolution
Domain name resolution refers to the process of converting a server name into a specific IP 
address for TCP/IP communication. Domain name resolution is an integral part of the server 
communication method. Since IP addresses can vary based on use of DHCP or proxy server 
techniques, using the server name is a consistent way to reference a server. 

Name resolution can be accomplished many different ways and no one way is preferred for Net UI 
purposes. These methods include WINS, DNS, HOST or LMHOST.

Some considerations when setting up name resolution include:

• firewall cannot prevent name resolution; in other words, DNS server cannot reside inside the 
firewall because remote clients need the server to perform the name resolution

• if you are using a proxy server for IP addresses outside your internal LAN, the proxy server 
must have a connection to the Net UI server and must be able to perform name resolution

Restricted Features

Modules Not Available with Net UI Thin Client
The Net UI thin client allows you to minimize network traffic for remote clients in a number of 
modules. However, some modules do not take advantage of the Net UI features at this time. This 
means that a remote client must access the application programs the same way as a client on the 
LAN. This generally results in unacceptable performance from a slow speed remote client.

The following modules do not take advantage of Net UI:

• Business Intelligence (BISM) Module

• Electronic Data Interchange (EDIM) Module

• Engineering (ENGM) Module

• Manufacturing Analysis (MMAM) Module

• Rules Based Pricing (RBPM) Module

• Sales Analysis (SAAM) Module

• Shop Floor Tracking and Reporting (SFRM) Module 

• Sales Order Processing (SOPM) Module 

In order to use these modules from a remote client, you should consider using other remote client 
options like Microsoft Terminal Server and Citrix. Contact Fourth Shift Client Business Solutions 
for more information about this software.

Directory NTFS Directory Access

Windows Read

System32 or Windows Read
Net UI 11
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Printing Options
Fourth Shift generates several types of reports. When using a Net UI client, consider the following 
as you generate reports for the available types:

• Screen Reports. Screen reports can be generated by choosing either Print or Print Preview 
from the File menu. Print Preview uses the Fourth Shift Report Viewer. Reports are sent to the 
Windows default printer for the client by default.

See "What Reports Can be Previewed?" in the Fourth Shift Basics online manual for a list of 
modules where the Fourth Shift Report Viewer is supported.

• Batch Process Reports. When a batch process runs, reports are generated either to a file or 
the default printer for the server, not the Net UI client. If you wish to use the report file 
generated, the file must be viewed or transferred to the thin client after the processing is 
complete.

Data Import
The data import features in the System Control Module can be used to input data from a file. The 
Net UI client can run the data import features but several considerations may limit the situations 
where running data import is reasonable.

• Reference files such as macro files (*.MAC) must be available to the Net UI client. 

• Data files used as input must be visible to the Net UI client.

• Data import validation uses the FS.CFG file to confirm file locations using drive letter and 
directory specifications.

These restrictions mean that either a drive mapping must be available for the Net UI client which 
points to the files or the files must be copied to the client and the files accessed from there. For 
example, if you are running a remote client with a dial-up connection or across the Internet, you 
will need to map a drive to the import locations needed before starting the import process.

See "Using the Data Import Features" in the System Control online manual for more information 
on the data import feature.

DOS Commands and Batch Programs
Fourth Shift uses DOS commands and batch programs in several ways, including:

• Fourth Shift batch processes

• CIM Customizer batch processes

• EDIM and EDSM Module functions

Remote Net UI clients can not run DOS commands or batch programs. The following results can 
be expected.

• Fourth Shift batch processes. Execution of a Fourth Shift batch process containing one or 
more DOS batch programs is prohibited. No tasks in the Fourth Shift batch process are 
executed and a message box is displayed indicating the reason for the failure. For example, a 
Fourth Shift batch process containing the CMND or PROG task could not be run from a 
remote Net UI client. Use the BSET screen to review the batch processes that contain the 
CMND and PROG tasks.

• CIM Customizer tasks. Execution of a CIM Customizer task that specifies a DOS batch 
program is prohibited. The cause of the failure is displayed in a message box. For example, a 
CIM Customizer task that activates a batch process containing the PROG task could not be 
Net UI 12
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run from a remote Net UI client. Use the CACF screen to review the records which define how 
external applications are accessed by Fourth Shift.

• DOS internal commands. DOS internal commands, such as COPY and CHDIR, can be 
executed but can not receive input or display output. If an internal command requests user 
input, a message appears allowing you to terminate the process. This prevents the internal 
command from waiting indefinitely for user input that can not be entered. For example, if a 
batch process includes the CHDIR command and prompts you for a directory, it can not be run 
from a remote Net UI client.

• Restricted EDIM/EDSM functions. Several functions in the EDIM Module and EDSM Module 
can not be executed from a Net UI client because they contain DOS batch programs. These 
functions are:

- EXFC

- IMIB

- IMOB

- TRED

Screens Requiring Diskette Drives
Some Fourth Shift screens write data directly to a diskette drive. These screens are not available 
from a Net UI client. These screens include:

• APTP (A/P 1099 Processing) from the Accounts Payable Module

• COCP (Custom Order Copy) from the Custom Product Manufacturing Module

• GLCO (G/L Consolidation Process) from the General Ledger Module

• GLHP (G/L History Process) from the General Ledger Module

Client Installation Options

Web Page Access for Remote or Local Users
Net UI clients can install client components and start Fourth Shift using Microsoft Internet Explorer. 
The Run Net UI button on the web page uses the application, screen and help files installed on the 
client to access the Fourth Shift server. Fourth Shift security is used to determine user permissions 
once signed onto Fourth Shift.

This option is available on a local area network (intranet), but is probably most useful when 
implemented over the Internet. 

Web Page
A web page (FSWEB.ASP) is provided in the MFGSYS\WEB\NUIM directory that can be used to 
access Fourth Shift. See Installing Net UI for more information on implementing the web page.

The web page access can be implemented in many different ways to meet the needs of your 
users.

Considerations
Consider the following when using the web page startup method:

• If users need to use the web page to download the installation files and start Fourth Shift, the 
server must run Microsoft Internet Information Server (IIS) and the client must run Microsoft 
Internet Explorer 6.0 or greater.
Net UI 13
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• The Fourth Shift Report Viewer components are installed separately from the client 
components. The Report Viewer components must be downloaded in order to print from a 
remote thin client.

Client Installation with Remote Access
Net UI client components must be installed using package files created from the web page. 

Remote access installations do not use the traditional Setup program. The Setup program 
configures the client to require mapped drives and other LAN-specific components. Remote users 
must install using either the default web page packages or through manual steps. The installation 
steps are listed in detail in the Installing Net UI section of this manual.

The following directories are created by the installation process on the client to support Net UI 
operation remotely:

Client Installation with LAN Access
The Net UI client can be installed from the Setup program on the Fourth Shift CD-ROM. The Setup 
program installs Net UI client components that can be used on the LAN, but not with the Internet. 
In other words, the LAN setup does not install local files which allow Net UI remote clients to 
minimize the amount of information transferred between the client and server. The LAN installation 
uses a mapped drive, which points to the files on the server.

The CD-ROM installation for LAN access creates a Net UI shortcut in the Fourth Shift group. The 
Net UI client shortcut accesses the same Fourth Shift functionality as the Fourth Shift shortcut. 
However, the Net UI client shortcut starts in the "thin client" mode so the Fourth Shift application 
session will be running on the Net UI server, not on the client computer.

Component Installation Location Description

Net UI client files C:\FSTHIN\SYSTEM These files are used when you start a Net UI con-
nection.

Screen files C:\FSTHIN\S These files support the Net UI client files. They 
are the same as the files installed in the MFG-
SYS\S directory on your server.

Context-sensitive help 
files

C:\FSTHIN\H These files allow access to context-sensitive help 
from a remote Net UI client. These files are the 
same as the files installed in the MFGSYS\H 
directory on your server.

Fourth Shift Report 
Viewer 
(FSPRINT.EXE)

C:\FSTHIN\SYSTEM This file provides preview and printing capabilities 
from a remote Net UI client.

Crystal Reports com-
ponents installed with 
Fourth Shift Report 
Viewer

C:\WINDOWS\SYSTEM These files support printing of template-based 
reports.

Toolbar control update C:\WINDOWS These files support the "flat" toolbar.
Net UI 14
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Installing Net UI
Installation for the Net UI Module includes installing and configuring the server and clients. 

Installation Process: Server
The Net UI Module must be carefully installed and configured. Careful pre-installation planning will 
help to ensure a successful implementation. 

The installation process consists of the following tasks:

• Server Installation. The Net UI Module is installed on the Fourth Shift server like any other 
module. The module installation is used to establish the environment, Net UI server and 
default files used for configuration.

The server installation also creates the NETUI.INI file. See "Net UI Settings and Configuration 
Variables" in this manual for more information.

• Client Installation and Configuration. Install the client using either the workstation 
installation program or an alternate installation method from a web page. Review the "Client 
Installation Options" section in this manual for more information on each type.

Install .NET v2.0 Framework and Service Pack Prerequisite
If the Microsoft .NET Framework version 2.0 and its Service Pack 2 (or a later Service Pack) is not 
installed on the server and the client machines, then it must be installed before beginning.

Install Net UI Module on Windows Server
The Net UI Module is installed at the Windows server using the same method as all other modules.

If you installed all modules at once, this step was completed during the module installation for the 
rest of the system. This step is needed only if you are adding the Net UI Module to your existing 
system.

Note: The Net UI Server application is installed during this process and must be running on 
the server for clients to be able to log in. You should use the same user name to 
complete the installation as will be used to run the Net UI Server application. This 
guarantees that the installation program sets up the correct user profile. This is 
especially important when the server is a Windows Terminal Server, because each 
user is assigned a different Windows directory.

1. Use the SETUP program to install the Net UI Module.

See the Installing and Implementing Fourth Shift manual for detailed instructions on installing 
a new module. Be sure to run the SETUP program with “Run as administrator” as required.

2. Verify that a default Windows printer is defined.

3. Set up the appropriate security for the server directories. 

See "Net UI Security" in the What is Net UI? section of this manual for more information.
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Prepare for Client Access via the Internet
After completing the Net UI server module installation, several files must be copied to the web 
server to access Fourth Shift via the Internet. 

Note: These steps represent only one way to set up Internet access to Fourth Shift. You can 
implement Internet access differently if desired. For example, you could add the 
Fourth Shift access to your company web site. Use your internal resources to modify 
these steps accordingly.

Complete Server Setup
1. Go to the Web server machine.

2. Sign on as a user with administrator rights.

3. Map a drive to the FSHIFT directory on the Fourth Shift server. 

Note: Be sure to use the same drive letter as on the server. This is probably M:.

Website Install Utility
1. Go to the location specified by the WebNuimDir configuration variable. 

This location is probably \MFGSYS\WEB\NUIM\Setup.

2. Run FSWebSet.EXE.

Right-click the file and choose the “Run as administrator” function if the operating system 
requires it (i.e., Windows Server 2008, or later).

If you get a message asking if you want to allow the following program to make changes to this 
computer, click Yes.

3. Enter or verify the following information:

- Location of FS.CFG. This is probably M:\MFGSYS.

- Local FSWeb Path. This should default to the \InetPub\WWWRoot\FSWeb directory, 
which will be created if needed. Browse to the appropriate location if you created the 
directory in another location.

- Net UI Listen Port. Modify the port number if you changed the port number used on 
the Fourth Shift database server.

Note: You may need to open this port through the server’s Windows Firewall for it to accept 
connections from the client.

4. Click Install.

5. If you get a message asking if you want to create the FSWeb directory, click Yes.

6. Click Close when the file copy process is complete.

For Multi Net UI Server Installations
If you use multiple Net UI Servers, do the following:

1. Rerun FSWebSet.EXE for each additional instance.

2. If there was a Net UI installation from a version of Fourth Shift before R7.50C, then select Yes 
to the message: "The old version of FSWeb has been installed in this machine. The program 
will delete the old files and folders. Do you want to continue?"
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Final Steps
1. Publish the URL address to your users so they can begin using the new Web page by going to 

Microsoft Internet Explorer, and entering the following location:

http://ServerName.DomainName/FSWeb
(where ServerName is the name of the Net UI server and DomainName is the name of your 
domain.)

For example, you might enter: http://Server1.MyCompany.com/FSWeb

2. Start the Net UI server by going to:
Start > Programs > SystemName Fourth Shift > Net UI Server.

Installation Process: Client

Remote User Access: Thin Client
Remote client installations use the web page installed in the previous section to create a package 
for installation. You should not use the standard SETUP program to install remote clients because 
the configuration would assume that the client was on a local LAN. The Web page is designed to 
install only the components not already installed. If a component is installed at the correct version, 
no installation is completed.

The following workstation installation options are available from the web page:

• Default installation includes: Fourth Shift Net UI Base System, Fourth Shift Report Viewer, and 
Graph Viewer components. 

• Fourth Shift Application Help can be included if the check box Include Fourth Shift Application 
Online Help is checked.

The Web page will indicate if a download is needed based on a comparison of the current version 
of the files on your workstation and the current version of the files on the web server. The 
recommendations indicate if more recent files are available on the server or if any required 
components are missing.

The package file created from the web page can be saved (rather than opened immediately) and 
transferred to a user directly if needed. 

Install .NET v2.0 Framework and Service Pack Prerequisite
If the Microsoft .NET Framework version 2.0 and its Service Pack 2 (or a later Service Pack) is not 
installed on the server and the client machines, then it must be installed before beginning.

Additional Configuration
In order to complete the installation from the web page, specific security settings are needed. 

The following steps must be completed on each remote workstation. These instructions are based 
on Internet Explorer 7. For other versions of IE, your exact steps may need to be modified.

1. Go to the remote workstation. 

You may need to be logged on as the administrator on the computer to complete this 
process.

2. Start Microsoft Internet Explorer.

3. From the Tools menu, choose Internet Options.

4. Choose the Security tab.
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5. For the zone, select the Local intranet.

6. Click the Sites button.

7. On the Local intranet window, click the Advanced button.

8. Enter the website URL for the Fourth Shift web server.

9. Click the Add button.

10. Click Close to exit the Local intranet window.

11. Click OK to exit the first Local intranet window.

12. With the Local intranet zone selected, click the Custom level button for Security level for this 
zone.

13.  Scroll to ActiveX Controls and plug-ins section.

14. Enable all options under ActiveX Controls and plug-ins. 
Be sure to enable “Initialize and script ActiveX controls not marked as safe" so that the 
ActiveX controls can function on the client machine.

15. Click OK.

16. Click OK.

Fourth Shift Installation Steps
These steps require that the web server is running properly.

1. Using Microsoft Internet Explorer, go to the web page from which the installation is accessible.

2. Select a Net UI server to download the Net UI thin client you want to install. 

3. Check the option Include Fourth Shift Application Online Help if the Fourth Shift Help is 
needed on the client.

4. Click Download. 

The installation package is created. 

5. Specify whether you want to open the package immediately or save it to a disk location. 

- If you choose to open the package immediately, the selected components will be 
installed.

- If you choose to save the file to a disk location, the file can be copied to and used by 
multiple workstations. You must run the downloaded file before you can use Net UI. 
Saving the file will also allow you to right-click the file and choose the “Run as 
administrator” function if the operating system requires it (i.e., Windows 7, Windows 
Vista, or later).

6. In Internet Explorer, click the Refresh the web page button to enable the Run Net UI button.

7. Start Net UI from the web page by clicking the Run Net UI button.

8. Once installed, you can bypass the use of the web page to run Net UI. You can create an icon 
shortcut on the Desktop that starts the Net UI thin client. The command line for this icon may 
be similar to the following example:

C:\FSThin\System\FSGUIApp.exe -N server.domain.com 5432
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Local User Access: Thin Client
The local area network thin client access method requires access to the server as well as a 
mapped drive to the location where your Fourth Shift system is installed. These instructions 
assume you are using drive M:. Substitute your drive letter in these instructions as needed.

Start Installation

1. Verify that you have completed the necessary workstation preparation.

2. Go to the workstation.

3. Map the M: drive to the database server. 

4. Verify that the Reconnect at login check box is selected when you create this drive mapping.

5. Run the SETUP program from the M:\MFGSYS\CLIENT directory. 

Right-click the file and choose the “Run as administrator” function if the operating system 
requires it (i.e., Windows 7, Windows Vista, or later).

6. Click Next.

Note: SETUP may need to install several Windows components before installing Fourth 
Shift. You may have to restart the workstation once or more. In this case, SETUP 
automatically resumes after the workstation restarts.

7. Select the FS.CFG configuration file. The default is M:\MFGSYS\FS.CFG. Click OK.

8. Select the modules to install for this workstation. The System Control Module is selected 
automatically. 

Be sure to select the Net UI Module. 

9. Click Next.

10. Verify the selections before beginning the actual installation process. 

11. Click Back to return to a selection that needs to be updated.

12. Click Next. 

Files are installed for the workstation.

13. Click OK when the installation completion dialog is displayed. 

The installation continues.

Complete Installation
1. When the installation is complete, click Finish.

2. Review the C:\FSUSER\INSTALL.HIS file. 

A series of Advisory messages is displayed. 

3. Use the Appendix section of this manual to determine actions necessary for any errors.

Tips about Shortcuts
The thin client installation from the network creates a Net UI shortcut in the Fourth Shift folder. The 
standard client installation creates a Fourth Shift shortcut to access the main Fourth Shift program. 
Both shortcuts can be installed on the same workstation. These shortcuts allow you to easily 
switch from one client access method to another. For example, to use the Engineering Module, the 
standard client must be used. 
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This might be useful, for example, if you use the same computer when accessing the network 
locally and when traveling remotely. The standard client could be used locally and the thin client 
used when traveling.

Client Startup Methods

Accessing the Program
The shortcut used to start a Fourth Shift session depends on the type of client.

Click the Start button, and then point to Programs. Point to the folder that contains the Fourth 
Shift group, and then click one of the following:

• To use Net UI, click Net UI.

• To use the standard client, click Fourth Shift.

All three shortcuts can be present on the same client. This might be useful if you need to use 
functionality that is not available via a thin client. For example, you might use the thin client most of 
the time for performance reasons. However, if you need to use the functionality of the Engineering 
Module the standard client is required.

Steps for Starting Via the Web Page
After all installation requirements are met and modifications made, complete the following steps to 
start Fourth Shift from a remote workstation.

1. Verify that the Net UI workstation installation and modifications were completed.

2. Using Microsoft Internet Explorer, enter the following location:

http:\\ServerName\FSWeb (where ServerName is the name of the Web server).

3. Press Enter.

4. Select a Net UI server to which you want to connect.

5. Click the Run Net UI button.

6. Enter a Net UI User Identifier then click OK.

7. Enter a User Id and Password. 

8. Press Enter to sign onto Fourth Shift.
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Administering Net UI
Typical system administration is changed in some ways once you implement Net UI in your operation. 
Additional considerations are needed for tasks such as automated processing and configuration options. 
You may also need to complete additional changes when updates are needed in your environment.

Starting the Net UI Server from a Shortcut
The Net UI server controls whether client connections can be started. The Net UI server should be 
started after the database server processes are running.

1. Start the Fourth Shift database server processes. This allows access to the databases for 
application programs.

2. Click the Start button, and then point to Programs. 

3. Point to the folder that contains the Fourth Shift group, and then click Net UI Server.

4. Sign on from a Net UI client to test, if desired.

Performing Daily Backups
Your daily database backup process is only slightly affected by the use of thin clients. The Net UI 
server must be shut down and any thin client connections terminated before starting the backup 
process. See "Managing User Connections" in this manual for more information.

Database backups require a single point of control for the database. This means that all client 
connections must be terminated and the database must be brought up in single-user mode. 

The Fourth Shift database window indicates the number of current client connections. This number 
includes both thin and traditional clients.

Managing User Connections
The Net UI Server allows clients to connect to Fourth Shift by "listening" for requests from the 
client. Once the client is connected, another process is started on the server which is controlled by 
the client as long as the client is connected.

In order to complete intensive or exclusive processing on the server, like a nightly batch 
processing run, you may wish to stop the "listening" process so no new users can connect. You 
may also wish to close any open client connections. Additional command line parameters for the 
Net UI server can initiate the "stop listening" and "close connections" operations.

Menu Options
Through the user interface for the Net UI Server, menu options are available to support Net UI 
Server administration. The following options are available from the Actions menu:

• Close All Connections allows you to locate any running client connections and break the 
connection. A several second delay is used by the Net UI server to ensure that any database 
updates are complete before the connection is terminated.
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• Stop Listening closes the Net UI Server dialog box and stops the Net UI server but does not 
close any client connections. This option allows you to prevent new connections from being 
started. For example, you may wish to stop listening 10 minutes before closing any remaining 
open connections.

Command Line Options
The Net UI Server process is started using properties associated with a shortcut. These properties 
can include several additional parameters. You can also include the command line in a batch file 
or other automated process.

The standard properties for the shortcut look similar to the following:

M:\MFGSYS\SYSTEM\FSGUILSN   [port number]

Command line options can be added after the port number. These commands are used to seek 
out a running Net UI server and control the server without accessing the desktop. The command 
line options include:

For example, the command line to close any client connections for port 5432 would look like the 
following:

M:\MFGSYS\SYSTEM\FSGUILSN   5432   CLOSE

Net UI Client Shortcut Parameters
A shortcut is used to start a Net UI client connection when not starting from the web page. The 
shortcut properties contain detail about the server you connect to, the port number used and 
optionally your Net UI Id. The shortcut properties vary depending on if you are using a remote 
client or a local client.

The shortcut command line includes the following:

[location]\FSGUIAPP.EXE  -N [server]  [port]  [Net UI User Id]  

An example line might look like the following:

[location]\FSGUIAPP.EXE  -N server1  5432  AAA 

The target line contains the following parameters:

Option Description

CLOSE Locates any client connections associated with the port number and breaks the 
connection. Same as choosing Close All Connections from the Actions menu.

STOP Closes the Net UI Server dialog box and prevents new connections from starting. 
Same as choosing Stop Listening from the Actions menu.

Parameter Default Description

Program name FSGUIAPP.EXE program started from the remote client
For remote clients, this program is located in the 
FSTHIN\SYSTEM directory.
For local clients, this program is in the MFG-
SYS\SYSTEM directory.
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Examples Requiring Changes to Shortcut Properties
Except for adding your Net UI user identifier, it is unlikely that you will need to modify the default 
parameter values. However, the following events might require that some of these values be 
changed:

Net UI Settings and Configuration Variables
The Net UI Module installation and client sign-on add settings and configuration variables to the 
NETUI.INI and FS.CFG files. In addition, the MaxGUISessions variable has a different meaning 
when using the Net UI Module.

Standard Net UI Settings
The Net UI module installation creates the NETUI.INI file on the machine running the Net UI 
server. This file contains the [NetUI 9999] section. These settings specify the information 
necessary to start the Fourth Shift applications on the server. The settings include:

• ServerExe

• ServerMSSCmd

• UserDir

• AddToPath

See "Fourth Shift Settings File" in the System Administration online manual for more information 
on the specific Net UI server settings.

The Net UI Module server installation also creates the WebNuimDir configuration variable in the 
FS.CFG file on the server. This variable specifies the location of the Net UI components that must 
later be copied to the IIS server.

Startup mode -N parameter indicating that the client must connect to a 
Net UI server; the space following the parameter is 
optional

Server name NetUIServerName 
configuration variable

name of Windows server where the Net UI server is 
running

Port number 5432 port number that the client connects to on the server 
specified in Server name

Net UI Id n/a (not included in 
default shortcut target 
line)

optional; indicates your unique Net UI user id and 
causes thin client startup to skip Net UI id entry and 
proceed directly to the Fourth Shift master menu 
after sign-on

Event Action

Application programs moved to a new server Modify the Server name parameter value; new location 
must match location specified by NetUIServerName 
configuration variable

Server port number change Modify port number to match that used by server

Parameter Default Description
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Client Sign-On
The first time a Net UI client is used to sign onto Fourth Shift, the ThinClientId setting is created in 
the [NetUI 9999] section of the NETUI.INI settings file on the client.

ThinClientId is initialized with the Net UI Id value you entered when starting a Net UI client 
connection. This setting identifies the client that is accessing the server and it defaults the next 
time you sign on.

MaxGUISessions Variable
The MaxGUISessions configuration variable defines the maximum number of Fourth Shift 
connections the server can run at one time. Each user identifier counts as one session. You may 
wish to restrict the number of sessions available if you encounter performance problems.

If you are unable to start a session from a thin client, the MaxGUISessions configuration variable 
may need to be changed. This variable specifies the number of sessions allowed on the server. 
The default value is 200.

If your server has reached the number of sessions allowed by the MaxGUISessions variable, do 
one of the following:

• Increase the MaxGUISessions value. The value of this variable does not significantly impact 
client performance. You may be able to increase the MaxGUISessions value if your user 
licenses allow.

• Connect to another Net UI server. If you have multiple Net UI servers, try starting a session 
on another server that has not reached its session limit.

• Run a traditional client. If possible, use the traditional client configuration until a thin client 
session is available.

UserDir Location
The UserDir configuration variable is used to define a unique location for files created when a user 
is signed onto Fourth Shift. Each client must have a user-specific subdirectory on the Net UI 
server. This subdirectory has the same name as the Net UI User Id entered when a Net UI client 
access a Net UI server. 

When using a thin client, the @NETUIID@ value is appended to the UserDir\SystemName 
location. This value indicates that the Net UI thin client identifier is used to specify a subdirectory. 
For this reason, the Net UI thin client identifiers must also be unique.

The standard configuration variable looks similar to the following:

UserDir=c:\fsuser\[SystemName]\@NetUIId@
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Multiple Net UI Server Processes
The Net UI Server controls user access to the Fourth Shift system. There is a one-to-one 
relationship between a Net UI server and a Fourth Shift database. You may need to run more than 
one Net UI server on a specific Windows server to support situations like multiple language 
versions of Fourth Shift or use of a live and test system.

A series of changes are needed to enable this capability. All the changes are made on the 
Windows server where the Net UI server process is running.

Select Port Numbers
A port number is similar in concept to a telephone number. Fourth Shift clients specify the port 
number they are trying to "call" to connect to the Fourth Shift server. The server must also 
designate the same port number as the one that "listens" for a client connection request. The 
Setup program specifies a default port number for clients and servers during installation.

If additional Net UI servers are needed, a unique port number must be assigned to each server 
process.

1. Open Windows Explorer.

2. Go to the Windows\SYSTEM32\DRIVERS\ETC folder.

3. Use NotePad to open the SERVICES file.

4. Review the port numbers currently in use and select one not in use for your new Net UI server.

5. Save and close the file.

Create Net UI Server Shortcut
Additional shortcuts can be defined using the original as a starting point. The new port number 
must also be assigned to the shortcut.

1. Go to the Windows directory. 

2. Select the Profiles\All Users\Start Menu\Programs\Fourth Shift folder.

3. Highlight the shortcut for Net UI Server.

4. From the Edit menu, choose Copy.

5. From the Edit menu, choose Paste.

6. Highlight the shortcut for Copy of Net UI Server.

7. Change the shortcut description. 

Use a description that explains why you need a second Net UI server, like Net UI for German 
system.

8. With the shortcut selected, choose Properties from the File menu.

9. Go to the Shortcut tab.

10. Change the port number to the newly selected port number.

11. Click OK.
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3. Update NETUI.INI File
Several changes are needed to the settings in the NETUI.INI file. The section of the NETUI.INI file 
looks similar to the following:

[NetUI  9999]
ServerExe=m:\mfgsys\system\fsguisvr.exe
UserDir=C:\fsuser\@NETUIID@
FSCFG=m:\mfgsys\fs.cfg
AddToPath=M:\mfgsys\system

For more information about these settings, see "Fourth Shift Settings File" in the System 
Administration manual.

Complete the following updates:

1. Use Notepad to open the NETUI.INI file in the WINNT or Windows directory.

2. Go to the [Net UI 9999] section.

3. Copy the existing [NetUI  9999] section and paste the section elsewhere in the file.

4. Update the port number to the newly selected port number.

5. Update the FSCFG setting to the location of the correct configuration file. 

For example: FSCFG=g:\mfgsys\fs.cfg.

6. Add the AddToPath setting if you wish to be sure that a specific location is added to the path 
when running this Net UI server. 

This path is used for the connection started on the Windows server when the client accessed 
Fourth Shift.

7. Save and close the NETUI.INI file.

8. Start the Net UI Server to verify that you can start the process successfully. 

If you have problems, verify all the configuration steps listed here.

Update Client Access Shortcuts
When clients access a specific Net UI server, the port number must be identified. To access the 
new Net UI server, be sure to use the correct port number.

Shortcut properties should look similar to the following:

[location]\fsguiapp.exe   -N  [server]  [port]

1. Create a new shortcut where the user will access it. 

These instructions assume you are creating the shortcut on the desktop.

2. From the right mouse button, point to New and then choose Shortcut.

3. Enter the command line including the required port number.

4. Click Next.

5. Enter a name for the shortcut.

6. Click Finish.

7. Test the shortcut and verify the correct system is accessed.
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Net UI Error Messages
The following errors might occur when using a Net UI thin client.

This function is not available from a Net UI thin client. Use the Fourth Shift fat 
client.
A Net UI thin client does not support functionality such as the additional Engineering (ENGM) 
Module. A standard Fourth Shift client must be used to access these features.

See "Restricted Features" in this manual for more information.

Your local Net UI does not match the server's version. Update your local install.
The Fourth Shift server has been updated with a newer version of Fourth Shift. Update your client 
by running the appropriate client installation.

Your local Net UI install in <directory> does not contain the [contents].
The specified directory does not contain the definitions required to perform this action. Either the 
screen or help definitions are missing.

• If the screen definitions are missing, the workstation installation did not install all components. 
Complete the workstation installation again.

• If the help definitions are missing, it is likely that the minimum workstation installation was 
completed from the web page. The minimum workstation installation does not include help 
definitions. Select the Fourth Shift application help check box from the web page.

Unable to execute Seqn = 99 of this batch process. A PROG or CMND task that 
specifies a DOS batch program cannot be executed under Net UI.
Net UI thin clients cannot run DOS commands or batch programs. If you attempt to execute a 
Fourth Shift batch process containing one or more DOS batch programs, no tasks in the batch 
process are executed and the error is displayed. Use the BSET screen to review the batch 
processing that contain the CMND and PROG tasks and execute these tasks from a standard 
Fourth Shift client.
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